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The Dashboard and Reports User Guide provides an overview of the Oracle Instantis EnterpriseTrack 

dashboard and reports module. It shows you how to create and modify your dashboard, and how to 

generate and modify standard, Ad-hoc, and user-defined reports. 

 

In This Section 

Document Conventions ............................................................................................................................ 5 

Terminology ................................................................................................................................................. 5 

 
 

Document Conventions 

The following conventions are used in this manual to convey instructions and information:  

The description of a menu item and its sub-items is described in this document as (Page Menu) View > 

Toolbar >Display Print-Data Toolbar, where you should click on the View Page Menu, then find the 

Toolbar sub-item and then click on the Display Print-Data Toolbar sub-item. 

 Screen names and field names are in bold text. 

 The actions you need to take on each screen are in bold text. 
 

Terminology 

The following terminology is used in throughout this guide. 

 Dashboard component – A single graph. 

 Canvas or One Dashboard – A set of 1 or more graphs on a single screen. You can resize layouts in 2x1, 
2x2, 3x3 or any other size you want. 

 

About this Manual 

Getting Around in EnterpriseTrack 
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In This Section 

Username and Password ........................................................................................................................... 6 

Using the Top Navigation Bar .................................................................................................................. 6 

Left Navigation Bar ..................................................................................................................................... 6 

Navigating within EnterpriseTrack .......................................................................................................... 6 

Navigating to the Dashboard and Reports Module ............................................................................ 7 

 
 

Username and Password 

To log into your system, enter your username and password in the appropriate fields and press the Login 

button. 
 

Using the Top Navigation Bar 

When you log into the system, you will see the Top Navigation bar. The Top Navigation Bar contains the 

Application Level Menu, and depending on the context, a Module Level Menu. 
 

Left Navigation Bar 

To display the Left Navigation Bar, from the Top Navigation Bar select the View menu and choose Display 

Left Navigation. Select if you want to display icons only or icons and text. 
 

Navigating within EnterpriseTrack 

Navigating within EnterpriseTrack is easy using the various menu options. The menu system consists of an 

Application Level Menu, Module Level Menu, Page Level menu, and an Item Level Menu. Common functions 

are grouped together throughout the application. 

 Application Level Menu  

This menu appears in the Top Navigation Bar and provides access to all major modules and components 

of EnterpriseTrack.  

 Module Level Menu  

This menu appears on the left side of the Top Navigation Bar when you are in a specific module of the 

application, specifically within a particular Idea, Proposal or Project. It provides access to commonly 

used functions within the module.  

 Page Level Menu  

This menu appears within each page of a module and provides access to functions that are relevant only 

to that page. 

 Item Level Menu  

This menu appears within each page. It allows you to perform actions specific to that item.  
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Navigating to the Dashboard and Reports Module 

 To navigate to the dashboards, from the Top Navigation bar select Go To >Dashboards> View. 

 To navigate to the Reports section, from the Top Navigation bar select Go To >Reports> View. 
 

EnterpriseTrack Dashboards are designed to provide graphical displays of proposal, project, resource, 

finance information along various X axes like organization, time, classification fields, strategy nodes etc. It is 

highly flexible and enables you to create your own dashboards, share between selected users, or globally to 

all dashboard viewers.  

EnterpriseTrack comes with a variety of pre-made dashboard widgets (components) that you can use to 

build a specific dashboard view that meets the different needs of your business. All dashboard widgets come 

with pre-built filters. 

In This Section 

Viewing Dashboards ................................................................................................................................... 7 

Components in the Dashboard ............................................................................................................... 8 

Managing Dashboards ............................................................................................................................... 11 

Creating a New Dashboard .................................................................................................................... 12 

Available Dashboard Components ....................................................................................................... 15 

Working with Project Bubble Charts................................................................................................... 25 

Dashboard Component Properties ...................................................................................................... 28 

 
 

Viewing Dashboards 

To view dashboards, from the Top Navigation bar, select Go To > Dashboards > View. 

You can select the type of Dashboard you want to view using the Select Dashboards pull-down menu on 

the top right corner of the screen. 
 

Select Dashboards 

From the Select Dashboard pull down menu you can view the list of dashboards that are available to you. 

This list contains various sub-groupings with individual canvases under each grouping. 

 My Dashboards 

Displays the dashboards that you have created. 

 Shared Dashboards 

Displays the dashboards that have been shared. You can copy and modify the shared dashboard. 

 Pre-defined Dashboards 

These dashboards are predefined in the system.  

Working with Dashboards 
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  Executive Dashboard  

Displays four high level visual reports:  

 Project Count by Status 

 Average cycle time by executive 

 Aggregate Month-by-Month Financial Savings for all projects 

 Associated Active Members 

Clicking on any of these graphs gives you a second level of detail. You can also filter the displayed data 

by Division and Year. 

 Project Dashboard  

Displays various charts and tables based on your project association. 

 Project Timelines 

 Primary Metrics 

 Aggregate Month-by-Month Financial Savings for all projects 

 Open Deliverables 

 Open Tasks 

 Open Issues 

 Global Dashboards 

These dashboards can be viewed by all dashboard users. 

 
 

Refresh Dashboards 

To refresh a dashboard, click on the  Refresh button. The graph is recomputed using the latest data in 

the system. You can also update each component in the dashboard separately. 
 

Components in the Dashboard 

A component is a single graph that shows information on project, proposal, resource, or finances etc. A 

dashboard can contain multiple components. The table below describes the icons that are displayed on the 

component bar. 

Icons Description 

 Click to open the Inline Filter box. 

 Click to set filters and display options for each component.  

 Click to generate a PDF. 

 

 

Click to maximize or minimize the component screen. 

 Click for a description of the component. 
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Inline Filter 

Inline Filters provide instant access to some of the most commonly used filter fields. Inline Filters are simple 

to use. For more information, see topic Using In-Line Filters.  
 

Filters and Display Options 

Each component has filters, display options, and chart display options that you can set when you add 

components to your dashboard, or at the component level.  

Changing Dashboard Component Filters 

To change dashboard component filters, do the following:  

1) From the top banner of the component, click the Edit Filters and Display Options  button. 

2) From the Filters tab, click the Expand All  button to expand the filter categories. You can select 

the Collapse All  button to collapse the list. The filter list is either expanded or collapsed based on 

the settings selected by your Administrator. 

3) Make the necessary changes and click the Apply button to set these filters for the current run of the 

component, or click the Save button to save the filter settings for future use. 

Changing Display Options 

You can personalize the look the of your dashboard component by adding or modifying the header, footer, 

vertical axis title, horizontal axis title, left and right tics. You can also change the general display by changing 

the chart color, font, font color, size, or the background color.  

To edit the general display options associated with a dashboard component, do the following: 

1) From the top banner of the dashboard, click the Edit Filter and Display Options  button. 

2) Click the General Display Options tab. 

3) Click the Expand All   button to expand the categories. You can select the Collapse All   

button to collapse the list. The list is either expanded or collapsed based on the settings selected by 

your Administrator. 

4) Select a default font and text size. 

5) From the color table, select a color from the drop-down menu and click on the Add button. The 

colors displayed are the colors used to create your dashboard. Click on the right   or left 

 arrow buttons to rearrange the color selection order.  Click Remove to remove that color 

from the color table. 

6) Enter a name to display on the Header, Vertical Axis Title, Horizontal Axis Title, and Footer. 

7) Choose a font, font size, alignment, font color, and background color. You can also choose to disable 

the Header, Vertical Axis, Horizontal Axis and Footer by clicking the Disable box. 

8) Make the necessary changes and click the Apply button to set these options for the current run of the 

component, or click the Save button to save the settings for future use. 

Changing Chart Display Options 
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You can change the way data is displayed on a dashboard component chart by selecting the Chart Display 

Options tab. You can choose to display the data as bar charts (with horizontal stacking, or vertical 

stacking), or as line charts (with row lines, percent lines or stack lines), or as pie charts. 

Note: The allowed chart types may vary from component to component 

depending on the data and functionality. 

You can further customize these bar charts and line charts by modifying the options you see on the Chart 

Display Option tab. 

To edit the chart display options associated with a dashboard component, do the following: 

1) From the top banner of the dashboard, click the Edit Filter and Display Options   button. 

2) Click the Chart Display Options tab. 

3) Click the Expand All   button to expand the categories. You can select the Collapse All    

button to collapse the list. The list is either expanded or collapsed based on the settings selected by 

your Administrator. 

4) Select the type of chart (Bar or Line). Select the type of bar chart (Stack Bars, Group Bars, or Row 

Bars), Line chart (Row Lines, Stack Lines, or Percent Lines), or Pie chart. 

5) The options you see may vary based on the type of chart you chose. Make the necessary changes and 

click the Apply button to set these options for the current run of the component, or click the Save 

button to save the chart settings for future use. 
 

Maximizing and Minimizing Components 

 Maximize Components 

Click the  Maximize Component button to expand each component. 

 Minimizing Components 

Click on the  Restore button to restore the component. 
 

Dashboard PDF 

EnterpriseTrack allows you to save your Dashboards as a PDF file. You can choose to save either the 

complete Dashboard view (i.e. Executive Dashboard, etc.) or you can choose to save any one of the graphs 

that make your Dashboard. 

Generating a document in PDF for the entire Dashboard 

To create a document in PDF that contains all the components of your Dashboard, do the following:  

1) Click the PDF  icon in the top right-hand corner of your screen. 

2) Choose the layout of your .pdf file by selecting the number of components (Project Count, Cycle Time 

etc.) you wish to see on each page of your .pdf document.  

3) When the system creates a document in PDF in a new window, you can save or print this document 

from this new window. 

Generating a document in PDF for each component of your Dashboard 
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To create a document in PDF of a particular component (e.g. Cycle Time) of your Dashboard, do the 

following:  

1) Click the PDF  icon in the title bar of that particular component. 

2) When the system creates a document in PDF in a new window, you can save or print this document 

from this new window. 
 

Mouse-Over 

You can mouse-over the components to view the values in the bars. 
 

Drill-Down 

On some components you can click on the bar to drill down to view detailed information. The information 

is displayed either as a list or a graph.  
 

Managing Dashboards 

The Manage Dashboards screen allows you to create, copy, paste, and share dashboards. You can 

customize your dashboard by adding, editing, or deleting components that make up your dashboard. Filters 

can also be set for each component. 

To access the Manage Dashboard screen, from the Top Navigation bar select Go To >Dashboards> 

Manage. If you are already viewing your dashboard, you can click on the  Manage icon. 

Use the Tree pane, List pane, and the Details pane to select and manage your dashboards. 
 

Tree Pane 

The Tree pane displays all the dashboards in the system. The dashboards are organized into folders.  

My Dashboards folder contains all the dashboards that you have created. 

Shared Dashboards folder contains all dashboards that have been shared by other. 

Pre-defined Dashboards folder contains all dashboards that have been already created in the system. 

These dashboards are usually only visible to Administrators. 

Global Dashboards folder contains all dashboards that are made available to users, depending on user's 

access profiles and permissions. 

Copy and Paste Dashboards 

You can use the Tree pane to copy an existing dashboard and paste it into My Dashboards. You can then 

edit the dashboard to add or delete components, or adjust filters. 

1) From the Tree pane, select the dashboard you want to copy and click on the Copy icon. 

2) Click on the My Dashboards folder and click on the  Paste icon. A copy of the selected 

dashboard is now in your My Dashboards folder. You can change the name of the dashboard by 

clicking on the Edit icon in the Details pane. 

Deleting Dashboards 
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Select the dashboard from the Tree Pane and click on the  Delete icon. 
 

List Pane 

The List pane displays all the components in the dashboard. Click on the components to view detailed 

information on each component. You can click on the Edit icon to edit your dashboard. 
 

Details Pane 

When you select a dashboard, the Details pane contains a General tab and a Sharing tab. You can click 

on the General tab to view or edit the dashboard name or description. You can also select if this is your 

default dashboard. 

The Sharing tab allows you to see if this dashboard is shared with other team members. You can also edit 

this tab to allow others to view your dashboard. 

When you select a component in the List pane, the Details pane contains a General tab, Filter tab, 

General Display Options tab, and a Chart Display Options tab. You can click on the Edit icon to 

modify the filters, the general information and the display options. 
 

Sharing Dashboards 

Based on your permissions, you may be able to share a dashboard. To share a dashboard:  

1) From the Manage Dashboards page, select the dashboard to be shared. 

2) From the Details pane click the Sharing tab.  

3) Click the Edit button.  

4) Click the Share Dashboard check box. The screen will refresh to display more options. 

5) Select the users you want to share this dashboard with, and specify the time period for which the 

dashboard should be shared. If you specify a time period, the dashboard will automatically be unshared 

when the time period comes to an end. You can also choose to allow other users to copy your 

dashboard. 

6) Click the Save button, or click Cancel to discard your changes.  
 

Creating a New Dashboard 

Follow the steps below to create a new dashboard. 

1) Navigate to the Manage Dashboard screen by selecting Go To > Dashboards>Manage from the 

Top Navigation bar. If you are already viewing a dashboard, click on the  Manage icon.  

2) From the Tree pane, select the My Dashboard folder and click on the  Add icon. All new 

dashboards must be created under the My Dashboard folder. The system creates a folder (New) under 

My Dashboards. 

3) In the Details pane, enter the following information:  

a. Enter a name for this dashboard. 

b. Choose if you want this dashboard to be active. Only active dashboards can be run. 
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c. Enter a description for this dashboard. 

d. Select if you want this to be your default dashboard. If you select Yes, then this dashboard is 

displayed when you select My Dashboards from the Top Navigation bar or the Left Navigation 

bar. 

4) Click the Save button, or click Cancel to discard your changes. 

5) From the Tree pane, select the dashboard you created and click on the Edit button in List pane. 

Note: Make sure that all your pop-up blockers are inactive. Clicking the edit 

button will open the component gallery in a new window. 

6) The Edit Dashboard screen is displayed. The Edit Dashboard screen allows you to create custom 

dashboard by using the drag-and drop feature to select components from the layout gallery. Select a 

category from the Category pull-down menu to see all the components in a particular category (for 

example, Project, Resource etc.). 

7) The component gallery is displayed on left side of the screen. Drag and drop the component into the 

layout grid. 

8) You can use the blue title bar to reposition the component on the layout grid. Click on the green arrow 

at the bottom right corner of the component to dynamically resize the component. You can remove 

components by dragging them into the Trash. 

9) Once you have selected all your components, click the Save Layout button. You can change the filters 

and other characteristics of the component after saving your initial layout. 

10) The Manage Dashboard screen is displayed again. In the List pane, select the first component by 

clicking on it. The General, Filter, General Display Options, and the Chart Display Options 

tabs are displayed in the Details pane. 

11) Click on the Edit button in the Details pane. Select the General tab to make changes to the 

component name, or select the Filter tab to modify the preset filter selection, or select the General 

Display Options tab to modify the general display options, or select the Chart Display Options tab 

to modify the chart display options. 

12) Click the Save button, or click Cancel to discard your changes. 

13) Click the Done button to return to the My Dashboard page. 
 

Setting Component Filters and Display Options 

You can set filters, general display options, and chart display options for the new dashboards you create. 

From the Filter tab, you can set filters for your component. From the General Display Options tab you 

can customize a component chart by adding header, footer, vertical axis, horizontal axis, left tics and right 

tics. You can also control the font, color, size, and background color used in your charts. From the Chart 

Display Options tab, you can choose the type of chart (Bar or Line or Pie). You can also use the various 

options to customize how the bar or line charts are displayed. 

You can selectively narrow the component filters and display options to enable only a subset of these 

settings to be editable, visible or editable/visible from the inline filter box by dashboard users. Check the 

Visible box if you want this filter or setting to be visible when the user clicks on the Edit Filters and 

Display Options icon  on the component. Check the Editable box if you want to allow users to set 

a different value for this filter, or display option. Check the In-line box if this filter will be available as an 

in-line filter option when the user clicks on the In-line filter icon . 
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To set the properties of the component filters, do the following: 

1) From the Details pane on the Manage Dashboards page, click the Filters tab. Click the Edit button 

to edit the component filters.  

2) Edit the various filter parameters. Check the Visible checkbox if you want the dashboard user to view 

this parameter on the filter page. Check the Editable box if you want to allow the dashboard user to 

edit the parameter on the Edit Filters and Display Options page. As a dashboard composer you can 

uncheck the Editable checkbox if you want certain filter parameters to remain unchanged. Check the 

Inline box if you want the parameter to appear on the Inline Filter box for this component. For more 

information on Inline Filters, see topic Using Inline Filters.  

3) From the Details pane click the General Display Options tab.  

4) Click the Edit button to edit the general display options. Check the Visible checkbox if you want the 

dashboard user to view this parameter on Edit Filters and Display Options page. Check the Editable box 

if you want to allow the dashboard user to edit this parameter.  

5) From the Details pane click the Chart Display Options tab.   

6) Click the Edit button to edit the chart display options. Check the Visible checkbox if you want the 

dashboard user to view this parameter on Edit Filters and Display Options page. Check the Editable box 

if you want to allow the dashboard user to edit this parameter.  

7) Click the Save button when you are finished making edits to the component filters and display settings; 

or click Cancel button to cancel your changes. 
 

Using In-Line Filters 

You can use the In-line filters to quickly modify filter parameters without navigating to the detailed filter 

page associated with the dashboard component. Selecting the Inline Filter  button on the component 

bar brings up a subset of filter parameters that you can modify. The dashboard component is then refreshed 

based on the selected filter settings without disturbing the other components on the page. Dashboard 

composers can select the parameters that can be visible on the Inline filter box.  

Modifying the In-line Filters 

To modify the in-line filters and view the dashboard display, do the following:  

1) From My Dashboards, select a dashboard component you want to modify. 

2) Click the Inline Filters  icon from the top banner. 

3) The filters that are shown in-line have been set during the dashboard creation. The benefit of this is that 

only a small subset of filters is shown in the in-line screen and the underlying component is left partially 

visible. Further, the refresh is done in place without disruption to the other components. 

4) Change the filters you want to modify and click the Apply button. The dashboard component is 

updated based on the filters you selected. When you select Apply, the change to the filter settings are 

applied only for this session and is not remembered for the next time you display this dashboard. 

5) You can select Save to save these filter settings such that future displays of this component will use the 

new settings to begin with. 
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Available Dashboard Components 

Alignment (Strategy) 

There are 3 dashboard components in this section.  

Component Description Drill 

Down 

Drills To 

Alignment List This chart displays the list of child nodes with their 

Measure values for selected Alignment node. 

You can click on a link to drill down to next level in the 

Alignment hierarchy. 

You can click on data or chart icons on a particular row to 

change the view. 

If there is more than one Alignment defined in the system, 

you must select one Alignment to display as a default. You 

can change this later. 

Yes Measure 

list, data, 

and chart 

Alignment-Mea

sure Time 

series 

This chart displays Measure Data on Y-Axis for selected 

Alignment node and the reporting period of X-Axis. 

For multi-Initiative system, choose an initiative that is to be 

displayed. 

No N/A 

Project % 

Completion by 

Alignment 

This chart displays the Percent Completion on Y-Axis for 

projects that qualify the filter criteria and Project 

Alignment (Strategy) on X-Axis. 

You can click on a bubble to drill down to the individual 

project. 

Yes Project 

Basics 

page 

 
 

Proposals (Charters) 

There is one component with the evaluation criteria. 

Component Description Drill Down Drills To 

Proposal 

evaluation 

Criteria 

 

This chart displays bubble chart of proposal (charter) 

for Proposal (Charter) that qualify the filter criteria. 

The X and Y Axis are represented by evaluation 

criteria. 

You must select the appropriate Initiative (if 

applicable) and the # of Proposal (Charter) to display. 

(Max 40 at a time). 

Yes Proposal 

Details 

Page 
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Projects (Subcategory: General) 

Component Description Drill Down Drills To 

Project 

Timelines 

 

The chart displays project timeline by phases for 

projects that qualify the filter criteria 

You can filter which projects to display using 

various filter criteria.  

You can also use Program as a filter. If selected, all 

projects belonging to the selected Program are 

displayed. 

You can also select the display timeline (Actual and 

Plan, Actual, or Plan). 

Yes You can choose if 

you want to drill 

down to the 

Project Basics, 

Project Dates, or 

Project Status 

Report page. 

Project 

Activities 

List 

 

The chart displays the list of activities assigned to 

any user. You can filter the list to view Open, Not 

Applicable, or Completed activities. You can also 

filter to view Non-WBS, WBS activities and also 

milestone and key milestone activities that are 

pending, past due, or completed. 

User can click on a link to drill down to view 

Activity details. 

Yes Project Roadmap 

page 

Project 

Issues List 

 

The chart displays a list of project issues.  

You can filter on My Projects and also search for 

other projects. You can also filter to view issues 

that are not assigned to a resource. 

User can click on a link to drill down to view Issues 

details.  

Yes Project Edit Issue 

page 

Project 

Bubble 

Chart 

 

Displays a project bubble chart based on your filter 

criteria. 

You can customize the chart by selecting the 

parameters to display on the X axis and Y axis. 

You can also swap the X and Y axis parameters. 

Click on a link to drill down to view the Project 

Basics page. 

Yes Project Basics page 

My Project 

Timelines 

 

The chart displays project timeline by phases for 

projects that the user logged-in user is a team 

member on. 

The set of these associated projects is shown as a 

list and a selection can be made of which ones to 

display 

The Actual and Plan timelines are displayed 

This component is provided for backward 

compatibility. This component is deprecated for 

Yes Project Dates page 
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Component Description Drill Down Drills To 

future use and the new Project Timelines 

component (above) should be used instead 

My Project 

Open 

Activities 

List 

This component displays a list of open activities on 

the projects that the logged-in user is a team 

member on 

There are no filters 

This component is provided for backward 

compatibility. This component is deprecated for 

future use and the new Project Activities List 

component (above) should be used instead 

No  

My Project 

Issues List 

 

This component displays a list of Issues on the 

projects that the logged-in user is a team member 

on 

There are no filters 

This component is provided for backward 

compatibility. This component is deprecated for 

future use and the new Project Issues List 

component (above) should be used instead 

No  

 
 

Projects (Subcategory: Count) 

Component Description Drill 

Down 

Drills To 

Project Count by 

Org 

 

The chart displays the number of projects on Y-Axis 

that qualify the filter criteria and Organization on 

X-Axis.  

User can select different level of organization to 

show on the X-Axis from the filter criteria. 

Projects that aligned to multiple organizations will 

be counted in multiple organizations.  

User can click on a bard to drill down to the list of 

projects that contribute to the bar. 

Yes Project Listing 

Report 

Project Count by 

Period 

 

The chart displays number of projects on Y-Axis 

that qualify the filter criteria and reporting period on 

X-Axis. 

Projects that start in one year and end in the next 

year will be counted in both years. 

Current quarter figures are as of the current date. 

Current year is displayed as YYYYYTD e.g. 

Yes Project Listing 

Report 
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Component Description Drill 

Down 

Drills To 

2009YTD. YTD means Year to Date. 

Prior quarter and year-end figures are as of the last 

day of the period. 

Click on a bar to drill down to the list of projects 

that contribute to the bar. 

Project Count by 

Status 

 

The chart displays the number of projects on Y-Axis 

that qualify the filter criteria and Current Project 

Status on X-Axis. 

User can click on a bar to drill down to the project 

types and then to the list of projects that contribute 

to the bar. 

The chart shows system wide project counts, 

except confidential projects, depending on the 

user’s permission. 

Yes Project Listing 

Report 

Project Count by 

Classification 

 

The chart displays the number of projects that 

qualify the filter criteria on Y-Axis and the selected 

classification field on X-Axis. 

Projects that are aligned to multiple classification 

fields will be counted in multiple classifications. 

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

Yes Project Listing 

Report 

Project Count by 

Alignment 

 

The chart displays the number of projects that 

qualify the filter criteria on Y-Axis and immediate 

children of selected Alignment node on X-Axis.  

This chart only works when the system has an 

Alignment (Strategy) configured. 

Projects that are aligned to multiple alignments will 

be counted in multiple alignments. 

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

Yes Project Listing 

Report 

Project Count by 

Phase 

 

The chart displays the number of projects that 

qualify the filter criteria on Y-Axis and Phases on 

X-Axis.  

Within a Phase projects are grouped by their 

on-time status (On Schedule, Schedule At Risk and 

Behind Schedule) 

If one roadmap is selected in the filter, then the 

phases are displayed the order specified in the 

Roadmap. 

If multiple roadmaps are selected in the filter, then 

Yes Project Listing 

Report 
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Component Description Drill 

Down 

Drills To 

the Phases are displayed alphabetically. 

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

Project Count by 

Phase Cycle 

Time Grouping 

 

The chart displays the number of Phases closed in 

the recommended Phase duration (Red, Amber, and 

Green) for projects that qualify the filter criteria on 

Y-Axis and Phases X-Axis.  

If one roadmap is selected in the filter, then the 

phases are displayed the order specified in the 

roadmap. 

If multiple roadmaps are selected in the filter, then 

the phases are displayed alphabetically. 

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

Yes Project Listing 

Report 

Project Count By 

Custom Field 

 

The chart displays the number of projects that 

qualify the filter criteria on Y-axis and the selected 

custom field on X-axis.You can click on a bar to drill 

down to the list of projects. 

Yes Project Listing 

Report 

 
 

Projects (Subcategory: Cycle Time) 

Component Description Drill 

Down 

Drills To 

Project Cycle 

Time by Period 

 

The chart displays projects cycle time by various 

Phases on Y-Axis for projects that qualify the filter 

criteria and reporting period on X-Axis. 

Projects that start in one year and end in the next 

year will be counted in both years. 

Current quarter figures are as of the current date. 

Current year is displayed as YYYYYTD e.g. 

2009YTD. YTD means Year to Date. 

Prior quarter and year-end figures are as of the last 

day of the period. 

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

Yes Project 

Listing 

Report 

Project Cycle 

Time by Role 

 

The chart displays the average cycle time for 

projects on Y-Axis that qualify the filter criteria and 

Users on X-Axis. 

Yes Project 

Listing 

Report 
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Component Description Drill 

Down 

Drills To 

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

The user selection is based on the System Access 

Profile definition then must be further defined by an 

individual user level selection. 

Project Cycle 

Time by 

Alignment  

 

The chart displays the cycle time for projects that 

qualify the filter criteria on Y-Axis and immediate 

children of selected Alignment node on X-Axis.  

This chart only works when the system has an 

Alignment (Strategy) configured. 

Projects that are aligned to multiple alignments are 

counted in multiple alignments. 

Click on a bar to drill down to the list of projects 

that contribute to the bar. 

User can select to display by Average or Median 

days of the cycle time. 

Yes Project 

Listing 

Report 

Project Cycle 

Time by 

Classification 

The chart displays the cycle time for projects that 

qualify the filter criteria on Y-Axis and the selected 

classification field on X-Axis. 

Projects that are aligned to multiple classification 

fields will be counted in multiple classifications. 

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

In a multi-Initiative system, a selection must be made 

to specify the Initiative to be used. 

Yes Project 

Listing 

Report 

Project Cycle 

Time by Phase 

(Box Chart) 

The chart displays box plot of cycle tie on Y-Axis 

and Phases X-Axis.  

If one Roadmap is selected in the filter, then the 

Phases are displayed the order specified in the 

Roadmap. 

If multiple Roadmaps are selected in the filter, then 

the Phases are displayed alphabetically. 

Only the completed phases will be counted towards 

calculation of the box plot as on-going (or active) 

phase does not have the actual end date of the 

phase. 

Yes Project 

Listing 

Report 

Project Cycle 

Time by 

Organization 

 

The chart displays the cycle time for projects on 

Y-Axis that qualify the filter criteria and 

Organization on X-Axis.  

User can select different level of organization to 

Yes Project 

Listing 

Report 
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Component Description Drill 

Down 

Drills To 

show on the X-Axis from the filter criteria. 

Projects that aligned to multiple organizations will 

be counted in multiple organizations.  

User can click on a bard to drill down to the list of 

projects that contribute to the bar. 

Project Cycle 

Time by Custom 

Field 

The chart displays the cycle time for projects on 

Y-Axis that qualify the filter criteria and the selected 

custom field on X-Axis. 

You can click on the bar to drill down to the list of 

projects that contribute to the bar. 

Yes Project 

Listing 

Report 

 
 

Projects (Subcategory: Finances) 

Components Description Drill 

Down 

Drills To 

Project Finances 

by Org. 

The chart displays the total for selected financial 

categories on Y-Axis for projects that qualify the 

filter criteria and Organization on X-Axis.  

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

The chart can be displayed on different levels of the 

defined organization structure by the filter 

selection. 

Yes Project 

Listing 

Report 

Project Finances 

by Period 

The chart displays the realized vs. forecast finances 

on Y-Axis for projects that qualify the filter criteria 

and reporting period on X-Axis. 

Current quarter figures are as of the current date. 

Current year is displayed as YYYYYTD e.g. 

2009YTD. YTD means Year to Date. 

Prior quarter and year-end figures are as of the last 

day of the period. 

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

The Forecast is the total finances that are current 

for all projects in the system. 

The Realized (Actual) is the total finances that are 

locked for all projects in the system. 

No N/A 

% of Projects with The chart displays the percent of projects with No N/A 
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Components Description Drill 

Down 

Drills To 

Finances by 

Period 

 

financial benefits on Y-Axis for projects that qualify 

the filter criteria and reporting period on X-Axis. 

If more than one financial category is selected, then 

the percent of projects with benefits is calculated 

based on the sum of the selected financial 

categories. 

If a project contributes to more than one year, the 

project’s financial impact will be attributed to the 

corresponding reporting period. 

Current quarter figures are as of the current date. 

Current year is displayed as YYYYYTD e.g. 

2009YTD. YTD means Year to Date. 

Prior quarter and year-end figures are as of the last 

day of the period. 

User can click on a bar to drill down to the project 

types and then to the list of projects that contribute 

to the bar. 

Finance Line 

Chart by Period 

 

The chart displays Net Finances on Y-Axis for 

projects that qualify the filter criteria and reporting 

period on X-Axis. 

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

Yes Project 

Listing 

Report 

Priority by 

Finances 

 

The chart displays the Risk or Priority on Y-Axis for 

the projects that qualify the filter criteria and 

Finances on X-Axis.  

User can click on a bubble to drill down to the 

individual projects. 

Yes Project 

Basics page 

Project Finances 

by Alignment 

 

The chart displays the sum of finances of projects 

that qualify the filter criteria on Y-Axis and 

immediate children of selected Alignment node on 

X-Axis.  

This chart only works when the system has an 

Alignment (Strategy) configured. 

Projects that are aligned to multiple alignments are 

counted in multiple alignments using specified 

percent allocation. 

Click on a bar to drill down to the list of projects 

that contribute to the bar. 

Yes Project 

Listing 

Report 

Project Finances 

by Classification 

The chart displays the sum of finances of projects 

that qualify the filter criteria on Y-Axis and selected 

Yes Project 

Listing 



 Working with Dashboards  

  23 

 

Components Description Drill 

Down 

Drills To 

 classification field on X-Axis.  

Projects that are aligned to multiple classification 

fields will be counted in multiple classifications. 

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

Report 

Project Finances 

by Phase 

 

The chart displays the sum of finances of projects 

that qualify the filter criteria on Y-Axis and Phases 

X-Axis.  

If one Roadmap is selected in the filter, then the 

Phases are displayed the order specified in the 

Roadmap. 

If multiple Roadmaps are selected in the filter, then 

the Phases are displayed alphabetically. 

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

Yes Project 

Listing 

Report 

Project Finances 

by Custom Fields 

 

The chart displays the sum of finances that qualify 

the filter criteria on Y-Axis and the selected 

classification field on X-Axis.  

You can drill down to a list of projects that 

contribute to the bar. 

Yes Project 

Listing 

Report 

 
 

Projects (Subcategory: Metrics) 

Component Description Drill 

Down 

Drills To 

% Change In 

Metrics By Period 

 

The chart displays the percent change in metrics on 

Y-Axis for projects that qualify the filter criteria and 

reporting period on X-Axis 

The chart can report on either primary project 

metric or specific metric type. (One at a time.) 

Projects that start in one year and end in the next 

year will be counted in both years. 

Current quarter figures are as of the current date. 

Current year is displayed as YYYYYTD. E.g. 

2009YTD where YTD means Year to Date. 

Prior quarter and year-end figures are as of the last 

day of the period. 

User can click on a bar to drill down to the list of 

Yes Project 

Listing 

Report 
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Component Description Drill 

Down 

Drills To 

projects that contribute to the bar. 

Project Metrics 

Timeseries 

 

The chart displays Primary Metrics on Y-Axis for 

projects that qualify the filter criteria and reporting 

period on X-Axis for the projects that the current 

user is associated with. 

System Administrator will not see any information 

when running this dashboard. 

No N/A 

 
 

Resource 

Component Description Drill Down Drills To 

Resource 

Certifications by 

Period 

 

The chart displays the number of user certifications 

by certification type on Y-Axis for projects that 

qualify the filter criteria and reporting period on 

X-Axis 

This chart shows information only when there is 

associated certification defined in the system. 

Current quarter figures are as of the current date. 

Current year is displayed as YYYYYTD. E.g. 

2009YTD where YTD means Year to Date. 

Prior quarter and year-end figures are as of the last 

day of the period. 

No N/A 

Resource Count by 

System Access 

Profile 

 

The chart displays a pie chart of distribution of 

resources that qualify the filter criteria. 

Resources are grouped by System Access Profile. 

The filters are available to select the resources 

based on the organization hierarchy and/or the 

status of the resource within the system. 

No N/A 

Resource 

Certifications by 

Org 

 

Displays the number of certifications for resources 

that qualify the filter criteria on Y-Axis and 

organization on X-Axis.  

This chart shows information only when there is 

associated certification defined in the system. 

User can click on a bar to drill down to the list of 

projects that contribute to the bar. 

The chart can be displayed on different levels of the 

defined organization structure by the filter 

selection. 

Appropriate Initiative should be selected in filter. 

No N/A 
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Component Description Drill Down Drills To 

Planned/Actual 

Utilization (%)  

 

The chart displays Heat map by resource.  

The user is allowed to select multiple initiatives if 

more than one is configured. 

This chart is associated with PMO module, thus if 

PMO feature is not used, this might not be available. 

Both plan and actual % are always displayed. 

Display can be configured for daily or monthly. 

No N/A 

Planned/Actual 

Effort (Hours) 

 

The chart displays Heat map by project.  

The user is allowed to select multiple initiatives if 

more than one is configured. 

This chart is associated with PMO module, thus if 

PMO feature is not used, this might not be available. 

Both plan and actual hours are always displayed. 

Display can be configured for daily or monthly. 

No N/A 

Planned/Actual 

Effort (Hours) by 

Project Type, or by 

Project 

Methodology, or by 

Organization, or by 

Alignment, or by 

Classification 

 

The chart displays Heat map by project.  

The user is allowed to select multiple initiatives if 

more than one is configured. 

This chart is associated with PMO module, thus if 

PMO feature is not used, this might not be available. 

Both plan and actual hours are always displayed. 

Display can be configured for daily or monthly. 

No N/A 

 
 

Working with Project Bubble Charts 

Bubble charts can give you powerful insights into your projects by allowing you to show projects in a 2 

dimensional chart, with each project represented by a bubble. Bubble chart provides extensive parameter 

options. 

You can use various parameters for the X axis and the Y axis. Both axes allow for choosing from a set of 

discrete properties of projects or from a set of values that can vary with time as the project proceeds. 

Discrete properties include: classification field, alignment mode, programs, process area, division, 

strategies, custom field of type list, or finance aggregate, etc. The time-varying status/values include: % 

completion, risk, finances, etc.  

The following is a list of all available parameter options:  

 Organization – Division 

 Organization – Business Unit 

 Organization – Location 

 Organization – Region 
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 Classification – Functional Area 

 Classification – Process Area 

 Classification – Project Source 

 Programs 

 Risk 

 Plan Effort 

 Actual Effort 

 % Completion 

 Project Status 

 Number of Open Issues 

 Number of Closed Issues 

 Number of Open Activities 

 Number of Closed Activities 

 Project Duration 

 Initial Planned Duration 

 Current Planned Duration 

 Actual Duration 

 Current Stage 

 Project End Date 

 Initial Planned Project Start Date 

 Initial Planned Project End Date 

 Current Planned Project Start Date 

 Current Planned Project End Date 

 Actual Project Start Date 

 Actual Project End Date 

 Strategies 

 Scorecards 

 Processes 

 Program 

 Finance Aggregate 

 Project Tracking Details 

 Project Type 

 Roadmap 

 Project Manager 

You can swap the X and Y axes for a visual rearrangement of the bubbles. The size and color of the bubbles 

can be driven by various parameters. You can choose fixed size or have it based on effort, team members 

(including and excluding TBD), and finance aggregate. The bubble color can also be fixed or be based on 

completion status, risk or schedule. 

Like the other dashboards you can mouse over the bubbles for more information, and you can click on the 

chart to further drill down. The Project Basics page is displayed. When you maximize the component you 

can view the dashboard component legends like the bubble color, and size. 
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If Finance Aggregate values are chosen as the parameter for the axes or for the bubble size, then additional 

dependent filters are shown to determine which finance values will be used for the chart. 

Creating a Project Bubble Chart 

To create a project bubble chart, do the following:  

1) Navigate to the Manage Dashboard screen by selecting Go To > Dashboards > Manage from the 

Top Navigation bar. If you are already viewing a dashboard, click on the  Manage icon.  

2) In the Tree pane, click on the name of your dashboard. 

3) In the List pane, click on the Edit button. The Edit Dashboards page is displayed. 

Note: Make sure that all your pop-up blockers are inactive. 

4) Clicking the Edit button will open the component gallery on the Edit Dashboards page. 

5) From the Category pull-down menu, select Projects. From the Subcategory pull-down menu select 

General.  

6) Select the Project Bubble Chart dashboard components from the gallery and drag it into the layout 

grid. 

7) Click the Save Layout button to save your dashboard layout. 

8) From the Manage Dashboards screen, select the Project Bubble Chart component from the List 

tab. 

9) Select the Filters tab from the Details pane and click on the Edit button. 

10) Choose an Initiative for the dashboard. 

11) From the Dashboard section, select the number of projects to show. 

12) Check the Inline box associated with each filter parameter if you want to be able to edit these 

parameters using the Inline Filters screen. 

13) From the drop-down list select a parameter for the X axis. 

14) Select a parameter for the Y-axis from the drop-down list. 

15) If you selected Finance Aggregate for X or Y axis, then you will see options to select a finance 

category, finance window, finance dataset, and specify a snapshot for plan. 

16) Select the bubble size. You can choose fixed or have it be based on effort, or team members (including 

or excluding TBDs). 

17) You can select if the bubble color should be fixed, based on completion status, risk, or schedule.  

18) Click on the Select Color link to choose a color. 

19) If you selected the bubble color to be determined by the Completion Status, then enter a percentage 

for the bubble colors. 

20) Click the Save button to save your changes. 

21) From the Details pane, select the General Display Options tab and click on the Edit button. 

22) Make the changes and click the Save button to save your changes. 

23) From the Details pane, select the Chart Display Options tab and click on the Edit button. 

24) Select if you want to enable bubble shadow, and choose the color, X offset, Y Offset and the width of 

the bubble shadow.  

25) Click the Save button to save your changes. 
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Swapping X-Axis and Y-Axis  

To swap the X-axis and Y-axis parameters, click the Inline Filters  button on the top banner of the 

Project Bubble Chart dashboard. From the Inline Filters screen, check the Swap X and Y Axis checkbox 

to swap the axis parameters. Click Apply to refresh the dashboard, or click Save to save the changes. 
 

Dashboard Component Properties 

 

Component 

Name 

Data 

Available 

for X-axis 

Data 

Available 

for Y-axis 

Category Sub-Categ

ory 

Default 

Drill Down 

Optional 

Drill Down 

Supporte

d Chart 

Type 

Project 

Cycle Time 

by Role 

Cycle 

Time 

Users Project Cycle 

Time 

Project 

Listing 

Report 

 Bar 

Resource Counts, Certifications 

Resource 

Certification

s by Period 

Certificati

ons 

Date 

Range 

Resources   Resource 

Certificati

ons 

Report 

Bar 

Resource 

Certification

s by Org 

Certificati

ons 

Organizat

ion 

Resources   Resource 

Certificati

ons 

Report 

Bar 

Resource 

Count by 

Access 

Profile 

User 

Count 

Access 

Profile 

Resources   Resource 

Listing 

Page 

Pie 

Metrics 

% Change In 

Metrics by 

Period 

% of 

Metrics 

Date 

Range 

Project Metrics Project 

Listing 

Report 

  

Project 

Metrics 

Timeseries 

Metric 

Value 

Date 

Range 

Project Metrics  Project 

Basics Page 

Line 
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Component 

Name 

Data 

Available 

for X-axis 

Data 

Available 

for Y-axis 

Category Sub-Categ

ory 

Default 

Drill Down 

Optional 

Drill Down 

Supporte

d Chart 

Type 

Project Progress 

Project 

Timelines 

Gantt bars Timeline Project  General Choose: 

Project 

Basics 

Gantt, 

Dates 

 Gantt 

Project 

Activities 

List 

Activities  Project General Project 

Roadmap 

Page 

 Table 

Project 

Issues List 

Issues  Project General Project 

Edit Issue 

Page 

 Table 

My Project 

Timelines 

Gantt bars Timeline Project  General Project 

Basics 

Page 

 Gantt 

My Project 

Open 

Activities 

List 

Activities  Project General Project 

Roadmap 

Page 

 Table 

My Project 

Open Issues 

List 

Issues  Project General Project 

Edit Issue 

Page 

 Table 

Alignment Nodes, Measures 

Alignment 

List 

Alignment 

Nodes 

 Alignment  Measure 

List, Data 

and Chart 

 Table 

Alignment-

Measure 

Timeseries 

Measure 

Value 

Date 

Range 

Alignment    Line 

Project % 

Completion 

by 

Alignment 

% 

Complete 

Alignm-e

nt 

Alignment  Project 

Basics 

Page 

 Bubble 
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Two levels of reports are available in EnterpriseTrack – project specific, and across projects. This section 

describes cross-project reports. You can access the cross-project reports by clicking on the Reports 

option in the Left Navigation bar, or select Go To> Reports >Standard and Go To > 

Reports>Ad-hoc from the Top Navigation bar.  

Visit each report to see what it displays. Cross-project reports can either be restricted to an initiative, or 

could be across initiatives. 

When you click on the Reports link, two or three sub-links are displayed under the Reports menu – 

Standard Reports, Ad-hoc Reports and Custom Reports. The Custom Reports link is displayed only 

if there are any custom reports configured for your system. 

In This Section 

Managing and Running Standard Reports ............................................................................................ 30 

Ad-Hoc Reports ........................................................................................................................................ 45 

User Defined Excel Reports ................................................................................................................... 47 

 
 

Managing and Running Standard Reports 

Standard Reports are all the predefined reports available in the system. To access Standard Report from 

the Top Navigation bar select Go To > Reports > Standard. 

In This Section 

Tree Pane .................................................................................................................................................... 30 

List Pane ...................................................................................................................................................... 31 

Details Pane ................................................................................................................................................ 31 

Running Standard Reports ...................................................................................................................... 32 

Pre-defined Standard Reports ................................................................................................................ 37 

 
 

Tree Pane 

The Tree pane displays all the reports in the system. The reports are organized into folders.  

 My Reports folder contains all reports that you have created. 

 Shared Reports folder contains all reports that have been shared by other. 

 Pre-defined Reports folder contains all reports that have been already created in the system. 

 Global Reports folder contains all the global reports. 

Working with Reports 
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 Custom Reports folder contains all reports that are customized for your system. 
 

Copy and Paste Folders 

You can use the Tree pane to copy an existing report folder and paste it into My Reports. You can then 

edit the folder by adding or deleting reports or adjusting filters. 

1) From the Tree pane, select the report folder you want to copy and click on the Copy icon. 

2) Click on the My Reports folder and click on the  Paste icon. A copy of the selected folder is now 

in your My Reports folder. 

3) You can change the name of the report by clicking on the Edit icon in the Details pane. 
 

Deleting Folders 

Select the reports folder from the Tree pane and click on the  Delete icon.  
 

Expanding Folders 

To expand all the folders in the Tree pane, click on the  Expand All icon. To collapse all the folders, 

click on the  Collapse All icon. 
 

List Pane 

The List pane displays all the reports under a folder. Click on the report to view detailed information in the 

Details pane. 
 

Copy and Paste Reports 

To copy a report, select a report from the List pane and click on the Copy icon. Select a folder under My 

Reports and click on the  Paste icon in the List Pane. 
 

Deleting Reports 

To delete a report, click on the  Delete icon in the List Pane. 
 

Running a Report 

To run a report using the existing filters, click on the  Run Report icon in the Action column. Click on 

the  Run with Filters icon to customize your report by adjusting filters. For more information, see 

topic Running Standard Reports. 
 

Details Pane 

When you select a dashboard, the Details pane contains a General tab and a Sharing tab. You can click 

on the General tab to view or edit the dashboard name or description. You can also select if this is your 

default dashboard. 



Dashboards and Reports User's Guide  

 

32 

 

The Sharing tab allows you to see if this dashboard is shared with other team members. You can also edit 

this tab to allow others to view your dashboard. 

When you select a component in the List pane, the Details pane contains a General tab, Filter tab, 

General Display Options tab, and a Chart Display Options tab. You can click on the Edit icon to 

modify the filters, the general information and the display options. 
 

Maximizing and Minimizing 

You can expand the pane by clicking on the  Maximize button. To minimize the pane, click on the  

Restore button. 
 

General Tab 

 You can click on the General tab to view or edit the report name or description.  
 

Filter Tab 

The Filter tab allows you to modify filters to create custom reports. 
 

Output Tab 

The Output tab allows you to select the output format.  
 

Schedule and Email Tab 

From the Schedule and Email tab, select run type (Manual or Scheduled). If you select Scheduled, then 

you can choose to send emails.  
 

History Tab 

From the History tab, you can view the history of this report. Click on the  Edit icon to select how 

long you want to save the reports. 
 

Running Standard Reports 

To run a standard report, do the following:  

1) Navigate to Standard Reports by selecting Go To > Reports > Standard from the Top Navigation 

bar, or select Reports >Standard from the Left Navigation bar. 

2) The Manage Reports screen is displayed. From the Tree pane select a reports folder.  

3) A list of reports is displayed in the List pane. Select the report you want to run. 

4) You can click on the  Run Report icon in the Action column to run the report using the existing 

filter and output criteria. 

5) To filter before running the report, click on the on the  Run with Filters icon. The Filters tab is 

displayed in the Details pane. 
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6) Click on the Expand All  button to expand the filter categories. You can click on the Collapse All 

 button to collapse the categories. 

7) Select the filters you want to use to generate this report. To run the report without changing the 

output parameters click the Run button. You can also select the Reset Filters button to reset the 

filters. For more information on modifying the filters for Project Finances Group Aggregate, Project 

Finances Element Aggregate, or Project Finances Element Monthly Detail reports, see topic Using 

Finance Aggregate Report Filters.  

8) To modify the output parameters, click on the Output tab. 

9) Select the output parameters like report format, primary sort direction, compress output, etc. 

10) Click on the Run button. The screen refreshes to display the report. 

11) Click on the Show Current Filters link to view the current filters. 

12) Click Done when you are finished viewing the report. 
 

Using Finance Aggregate Report Filters 

The screen samples below shows the additional filters associated with the Project Finances Group Aggregate, 

Project Finances Element Aggregate, and the Project Finances Element Monthly Detail reports. 

The (Set 1) and (Set 2) are two sets of filters for two sets of output columns in the Finance Group Aggregate 

and the Finances Element Aggregate reports. The two sets allow you to compare finance aggregate values. 

You can independently set three filters for each set. 

Project Finances Group Aggregate Filters 

 

Project Finances Element Aggregate Filters 

 

Project Finances Element Monthly Detail Filters 
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In addition to entering the Finances filters shown below, you can also choose the common Finance 

Aggregate Definition filters.  

 

The table below describes the finance aggregate related filters.  

Filters Pull-down Values Description 

Common Filters 

Date Range 

 

The range of months that are used to 

generate the aggregate value of the Total, 

Group1, Group 2 etc., columns in the 

aggregate reports. For Monthly reports, 

this determines the months that will be 

populated in the output, all other months 

will have 0 values. 

For Annual totals, use one of the 

different Fiscal Year choices. For 

Quarterly totals, use one of the different 

Quarter choices. If you want totals for a 

particular month, use one of the Month 

choices. For a range of months, use "Any 

Start or End Month" 

You can choose aggregation of past or 

future months. 

Finance 

Dataset 

 

This filter determines which set of 

month-by-month values for the 

Date Range specified above are 

considered for aggregation in the 

Aggregate reports, and which finance 

values are fed into the month-by-month 

columns as non-zero in the Monthly 

reports. 

For each project, the system displays by 

default the "Current" values in the 

Finance page, and is automatically 

updated from the Project Activities or 
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Filters Pull-down Values Description 

from the Project Team Finances 

(provided the Finance Template has been 

configured to receive these values). You 

can also take Snapshots of the "Current" 

value and store this as a "Plan" and not 

have it updated as edits are made or as 

the Project Activity and Project Team 

finances change. 

This Filter allows you to select which 

Dataset (Current or Plan) you are 

interested in outputting in the report. If 

you are using Lock months to lock 

finances, the filter also allows you to 

consider the Lock month in generating 

the aggregate for the other months. For 

example, you can choose to take values 

from before the Lock month if you go 

through a finance validation that ensures 

that the numbers before the Lock month 

have been checked. 

Further, the filter allows you to also 

consider this month (when the report is 

run) and take the Plan values from before 

this month and the Current values from 

after (and including) this month. 

Snapshot 

for Plan 

 

If the Finance Dataset filter refers to a 

Plan value, then the "Snapshot for Plan" 

further defines which of the Snapshots 

should be used for the report output. 

The Default Plan Snapshot is always at 

the top of the list. 

The system shows the complete list of all 

Snapshots taken in the drop-down list 

(up to a limit of 100). To ensure 

consistent aggregation of values, it is 

recommended that all users that make 

snapshots use a consistent naming 

scheme. 

Specific Filter for Element Monthly Detail Report 
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Filters Pull-down Values Description 

Finance 

Detail Level 

 

The filter sets the level of detail of the 

Finance element hierarchy that is shown 

in the report. This also sets the number 

of rows in the output per project. 

Total: means show only the top level 

(Total). 

Group: means show the Group level, one 

level below Total (up to 5, depends on 

number of Groups configured) 

Category: means show the Category 

level, 2 levels below Total 

Element: means show the Element level, 

3 levels below Total 

Show 

Upper 

Levels 
 

This filter decides if the output should 

show higher levels of the 

Finance items hierarchy when a lower 

level item is chosen in the 

Finance Detail Level filter above 

This is relevant if you are doing your own 

aggregation of the element level values 

using Excel and you do not want the 

Category, Group, Total level values to 

interfere with this aggregation. 

The table below describes the additional output parameters for the Project Finances Element Monthly Detail 

report. 

Output 

Parameters 

Description 

Starting Month Enter the starting month. This output setting decides which set of months will 

be shown in the report output. 

Number of 

Months 

Enter the number of months. For instance, you may set the number of months 

to 36 starting with January 2010 for several runs of this report. Then depending 

on the Date Range filter setting (above) varying sets of months of these 36 will 

be populated for different runs of the report. 

Break down 

Finance Details 

by Organization 

Select this check box to expand the finance details by organization. Each finance 

line item in the report is expanded and broken down to show the finance 

allocation by organization. 

Note: This report is usable only if the finance allocation percent totals 100%. 

The system displays a warning message if it does not equal 100%. 
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Pre-defined Standard Reports 

Listing Reports 

You can generate customized listing reports using the filter and output options. 

Project Request Listing 

Based on your filters, this report displays all project requests in the system. It displays the project request, 

the status, a description, division, business unit, primary contact, assignee, submission date, date 

accepted/rejected, and the evaluation score. The output choices are CSV, PDF and HTML.  

Note: Depending on your configuration, the Project Request Listing is the same 

as Ideas Listing Report label. 

Charter Request Listing 

Based on your filters, this report displays all charter requests in the system. It displays the charter ID, name, 

status, division, business unit, project leader, planned start date, actual start date, planned project close 

date, initial forecast savings, initial forecast cost, and the evaluation score. The output choices are CSV, PDF 

and HTML. 

Project Listing 

Based on your filters, this report displays all projects in the system. It displays the initiative, phase, status, 

plan, start date, program, and region. The output choices are CSV, PDF and HTML. 

Project Listing Report with Activity List 

Based on your filters, this report displays all projects with the activity list. It displays the project details, and 

the project activity details like the type, name, status, number of attachments, dates, and the status of 

milestones. The output choices are CSV, PDF and HTML. 

Resource Listing 

Based on your filters, this report displays all resources. It displays the name, resource type, email address, 

phone number, access profile, allowed roles, business unit, manager, and initiative. The output choices are 

CSV, PDF and HTML. 

Project Status 

Based on your filters, this report displays the status of projects. It displays the ID, name, status, team size, 

timesheet, related entities #, and activities # with milestones and key milestones. The output choices are 

CSV, PDF and HTML. 

Resource Status 

Based on your filters, this report displays the status of resources. It displays the name, login ID, status, last 

login date, timesheet, last timesheet submission date, and related entities. The output choices are PDF and 

HTML. 

Activity Detail Report 
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This is a detailed report on each activity associated with a project. You can filter on initiative, program, all 

project activities, LET (Labor Expense Type), labor expense categories, and resource related fields. You can 

use the output generated from this report to create custom User-Defined Excel reports to view 

activity-related information for a specific project or group of projects. The output includes LET and labor 

expense categories. The output choices are CSV, HTML, PDF, and XLS. 
 

Project Reports (Summary Reports) 

You can generate customized project summary reports using the filter and output options. 

Finance Summary Report 

Based on your filters, this report displays the finance summary. Before running this report, you must choose 

a Finance Template and the Finance Type (Plan or Actual) from the Filter tab. The output choices are CSV, 

PDF and HTML. 

Project Summary by Organization 

Based on your filters, this report displays the finance summary by organization. Before running this report, 

you must choose a Finance Template from the Filter tab. The output choices are CSV, PDF and HTML. 

Project Summary by Alignment Report 

Based on your filters, this report displays the project summary by alignment. It displays the processes, 

project count (active and closed) and the project finances. Before running this report, you must choose a 

Finance Template, the Finance Type (Plan or Actual), the Alignment List and Note from the Filter tab. The 

output choices are CSV, PDF and HTML. 

Project Summary by Project Source 

Based on your filters, this report displays the finance summary by project source. It displays project source, 

project count (active and closed) and project finances. Before running this report, you must choose a 

Finance Template from the Filter tab. The output choices are CSV, PDF and HTML. 

Project Summary by Program 

Based on your filters, this report displays the finance summary by program. It displays programs, project 

count (active and closed) and project finances. Before running this report, you must choose a Finance 

Template from the Filter tab. The output choices are CSV, PDF and HTML. 

Project Summary by External Factors 

Based on your filters, this report displays the finance summary by external factors. It displays the external 

factors, project count (active and closed) and project finances. Before running this report, you must choose 

a Finance Template from the Filter tab. The output choices are CSV, PDF and HTML. 

Project Summary by Process Area 

Based on your filters, this report displays the finance summary by process area. It displays the external 

factors, project count (active and closed) and project finances. Before running this report, you must choose 

a Finance Template from the Filter tab. The output choices are CSV, PDF and HTML. 

Project Summary Stats by Role 

Based on your filters, this report displays the project summary statistics by resource roles. Before running 

this report, you must choose an Initiative and Resource Role from the Filter tab. The output choices are 

CSV, PDF and HTML. 
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Closed Project Listing 

Based on your filters, this report displays all closed projects. It displays the initiative, project number, name 

and close date and project type. The output choices are CSV, PDF and HTML. 

Active/Close Project Report 

Based on your filters, this report displays all active and closed projects. It displays the initiative, project 

number, name and close date and project type. It also displays the finances associate with the project. The 

output choices are CSV, PDF and HTML. 
 

Project Report (Detail Reports) 

You can generate customized detailed project reports using the filter and output options. 

 Project Listing Report with Activity List 

Based on your filters, this report displays all projects with the activity list. It displays the project details, and 

the project activity details like the type, name, status, number of attachments, dates, and the status of 

milestones. The output choices are CSV, PDF and HTML. 

Project Listing by Role 

Based on your filters, this report displays the projects by resource roles. It displays the project sponsor, 

project metrics, project ID, name, development activity dates, post implementation activity dates, 

implementation dates, stress/load testing days, usability testing days, testing days, analysis tool days etc. 

Before running this report, you must choose an Initiative and Resource Role from the Filter tab. The output 

choices are CSV, PDF and HTML. 

Project Final Report 

Based on your filters, this report displays the project final report. The output choices are PDF and HTML. 

Project Review Report 

Based on your filters, this report displays the aggregate project review report. It displays the project name, 

manager, financial representative, and detail information on each project activity. The output choices are 

PDF and HTML. 

Project Control Report 

Based on your filters, this report displays the project control report. The output choices are PDF and 

HTML. 

Project Notes Report 

Based on your filters, this report displays the project notes report. The output choices are PDF and HTML. 

Project Issues Report 

Based on your filters, this report displays the project issues report. The output choices are PDF and HTML. 

Project Storyboard 

Based on your filters, a project storyboard is created. The output option is MS PowerPoint. Follow the 

instruction under the Help tab to export project data to Microsoft PowerPoint. 

Project Request Eval 
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Based on your filters, this report displays the evaluation of all project requests or ideas in the system. The 

output choices are CSV, PDF and HTML. 

Charter Eval 

Based on your filters, this report displays the evaluation of all charters in the system. The output choices are 

CSV, PDF and HTML. 
 

Project Reports (Spreadsheet Reports) 

You can generate customized spreadsheet reports using the filter and output options. 

Finance Aggregate Reports 

The Finance Aggregate Reports can be very useful to your business as they can be customized to your 

needs. Using EnterpriseTrack you can extensively configure finance reports by configuring the level of 

group, category, and element details. You can also configure based on time period (annual versus monthly), 

and by optional use of lock months. Also, your finances may involve separate Plan versus Actual, or a single 

set of numbers that starts off as Plan and then is updated each month into Actual for the previous months. 

You can create snapshots for comparisons by keeping the prior values. Regardless of how you are currently 

using the Finance module, the three Finance Aggregate Reports can be configured with the use of a small set 

of filters to create a report output that is best suited to your needs. You can also use these reports as data 

sources to generate highly specific output in the form of Excel charts, pivot table and any company-style 

formatted output (See topic Creating User-Defined Excel Reports). 

The three Finance Aggregate Reports provide increasing levels of detailed information. They also provide 

extensive columns of non-financial information about projects such as– organization, classification, users, 

custom fields, etc. The hierarchy of finance information can be visualized as:  

Total 

 Group1 

  Category 1.1 

   Element 1.1.1 

Total refers to the sum-total finance value of a Project. Group1,2,3,4,5 refers to the items in the Finance 

Template hierarchy you have configured just below the Total level. Categories are the items below Groups 

and Elements are the items below Categories.  

Sample Report 
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The sample below is an example of what you can do by using the data generated from the Finance Aggregate 

Reports as data sources to create custom generated user reports. 

 

Project Finance Spreadsheet Report 

You can generate the project finance report using the filter and output options. The report is displayed in 

Microsoft Excel. You must first download the template. The output is in CSV format. 

Project Detail Spreadsheet Report 

You can generate a detailed project report using the filter and output options. The report is displayed in 

Microsoft Excel. You must first download the template. The output is in CSV format. 

Financial Savings by Business Unit 

You can generate a financial savings report by business unit using the filter and output options. The report 

is displayed in Microsoft Excel. The output is in CSV format. 

Project Finances Group Aggregate 

You can generate a finances group aggregate report by using the filter and output options. The report is 

displayed in Microsoft Excel. The output is in MS-Excel format. For more information on filtering, see topic 

Using Finance Aggregate Report Filters. 

It displays:  

 New financial columns that sum up the Group1-5 and Total values over a chosen date range and chosen 
from actual, plan, before/after lock based on the filter settings. 

 1 project per row. 

 Aggregates and does not show monthly details. 

Project Finances Element Aggregate 

You can generate a finances element aggregate report by using the filter and output options. The report is 

displayed in Microsoft Excel. The output is in MS-Excel format. For more information on filtering, see topic 

Using Finance Aggregate Report Filters. 
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It displays:  

 New financial columns that sum up the Group1-5 and Total values over a chosen date range and chosen 
from actual, plan, before/after lock based on the filter settings. 

 Multiple projects per row. One row is shown for each configured item in the Finance Template 
hierarchy. 

 Aggregates and does not show monthly details. 

Project Finances Element Monthly Detail 

You can generate a finances element monthly detail report by using the filter and output options. The 

report is displayed in Microsoft Excel. The output is in MS-Excel format. For more information on filtering, 

see topic Using Finance Aggregate Report Filters. 

It displays:  

 Month by month values for the date range based on the filter settings. 

 Multiple projects per row. One row is shown for each configured item in the Finance template 
hierarchy. 

 

Resource Reports (Detail Reports) 

You can generate customized detailed resource reports using the filter and output options. 

Note: When running heatmap reports, you can choose to view or hide all rows 

with zero values. From the Output tab, select Yes for the filter Hide Rows with 

Zero effect.  

Resource Professional Certifications 

Based on your filters, this report displays all the certificates received by resources. The output choices are 

CSV, PDF and HTML. 

Resource Expertise/Skills 

Based on your filters, this report displays the skills and expertise the resources have. The output choices 

are CSV, PDF and HTML. 

Resource Assets 

Based on your filters, this report displays the skills and expertise the resources have. The output choices 

are CSV, PDF and HTML. 

Heat Map by Resource 

Based on your filters, this report displays a heat map by resource. The cells highlighted in green indicate that 

the resource is under-utilized, and cells highlighted in red indicate that the resource is overbooked. The 

output choices are HTML and CSV. 

Heat Map by Role 

Based on your filters, this report displays a heat map by resource roles. From the Filter tab, you must 

choose an Initiative before running this report. The output choice is HTML. 
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Note: The total capacity at the role level only indicates potential capacity. The 

capacity is counted more than once if a resource has multiple roles. 

Heat map by Project 

Based on your filters, this report displays a heat map by project. The output choice is HTML. If your report 

has a cell highlighted in orange, it indicates that the committed effort as a percentage of capacity for the 

activity is in the mid-range. If a cell is highlighted in red, it indicates that the activity's planned utilization is 

very high; and cells highlighted in green indicate very low utilization. 

Resource Utilization Chart Report 

Based on your filters, this report displays a heat map chart by resource. It shows the planned utilization % 

and the actual utilization % for all resources. The output choice is HTML. 

Project Effort Chart Report 

Based on your filters, this report displays a project effort heat map by project. It shows the planned and the 

actual effort. The output choice is HTML. 

Heat Map by Resource CSV 

Based on your filters, this report displays a heat map by resource. The output choices are HTML, XLS and 

CSV. 
 

Heat Map Legends 

 CP(hours)  

Resource Capacity. The number of working hours per week by a resource divided by the number of 

working days per week.  

Example: If a user works 40 hours a week, there are 5 work days in a week and 22 working days in a 

month, then the capacity for the resource for that month is 40/5* 22= 176 hours. Resource capacity is 

fixed and the number of work days in EnterpriseTrack is fixed at 5. General calendar holidays and 

non-working days do not affect resource capacity. 

 RQ(hours) 

 Pending/Unapproved Requested Effort for Resources. It is the sum of the demand for a role or 

resource in the form of allocations from projects. 

 CM(hours) 

Approved/Committed Effort for Resources. When Requested Effort (RQ) is approved it becomes 

Committed Effort and RQ can be approved is full or partial. If a resource role doesn't require an 

approved then as soon as effort is allocated it becomes committed effort. 

 TD(hours)  

Total Demand (RQ+CM). It is the sum of Requested Effort (RQ) for a role or resource and the 

Committed Effort (CM).  

 RQ/CP(Percent) 

Requested Effort as a percent of Capacity. 

 CM/CP(Percent) 

Committed Effort as a percent of Capacity. 

 TD/CP(Percent)  
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Total Demand as a percent of Capacity. 

 PL(hours) 

Planned Effort for Resources. The sum of an individual resource's planned effort for each assigned task 

for a given time period. It is not double-counted when rolled up by resource or role.  

 

Example: If John Smith plans to work 110 hours as a DBA and 40hrs as a Unix Administrator for the 

month of January, then the PL for John for the month of January is 110 +40 = 150 hrs.  If Mary Jane plans 

to work 100 hrs as a DBA in the month of January then the PL for DBA is 110 + 100= 210 hrs. The PL 

for Mary is 100 hrs. The PL for Unix Administrator is 40 hrs. 

 AC(hours)  

Actual Effort. The sum of the actual effort by a resource for a given time period. This can come from 

timesheets. No double counting is done when rolled up by resource or role.  

 

Example: If John Smith has worked 93 hrs as a DBA and 45 hrs as a Unix Administrator in January, then 

the AC for John is 93+45 = 138 hrs. If Mary Jane worked 97 hrs. as DBA in January, then the AC for 

Mary is 97. The AC for DBA is 93+97=190 and the AC for Unix Administrator is 45. 

 PL/CP(Percent)  

Planned Utilization. 

 AC/CP(Percent) 

Actual Utilization. 
 

Timesheet Reports 

You can generate customized timesheet reports using the filter and output options. 

Timesheet Report by Project 

Based on your filters, this report displays timesheet reports by projects. The output choices are CSV, PDF 

and HTML. 

If the date range is one week or less, the generated report provides a detailed view for each day of the 

week. If the date range is more than a week, the generated report displays a summarized view for the entire 

period. 

Timesheet Report by Resource 

Based on your filters, this report displays timesheet reports by resource. The output choices are CSV, PDF 

and HTML. 

Timesheet Detail Report 

This is a detailed report of timesheets. You can filter by Pull-down Status, Initiative, Timesheet Basics, 

Correction Date Range, Project Basics, Project Organization Hierarchy, Resource Basics, Resource 

Organization Hierarchy, Resource Filterable Custom Fields, Finances, Program, and Output Custom Fields.  

You can also set the following output filters: Compress Output, Show Cost, Show Project Overhead 

Categories, Show Activity Details Show Non-project Categories, Include disabled Time Reporting 

Categories, Show Actual Effort breakdown at day level, and Suppress rows where Actual Total Effort is 

zero. If you select the Show Actual Effort breakdown at day level option, the report displays the actual effort 

by resource assignment for each day. Leave this option unchecked to view actual effort aggregated for the 

selected time period. The output choices are CSV, PDF, and HTML with compression. 
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You can export the data generated by this report to Microsoft Excel to view the Plan versus Actual data and 

the cost across various dimensions. You can use Excel to format the data, group rows and columns, 

aggregate by quarters, years, or by fiscal period. 

Notes:  

 The Total Plan Effort column in this report is an information only column and 

the value will be the whole plan effort at activity level. This value may be 

repeated when the report is run to show the breakdown at day level, in such 

cases care should be taken not to double count the plan effort. 

 

 The cost data is shown only for users that have the required permissions to 

view cost information. 

 

 The resource rates are picked for the rate at assignment level. For 

non-project time and non-working time the standard rate at the resource 

level is used. 

 

 If the correction dates are specified, the output will display correction 

reports. If correction dates are not specified, the output will display 

timesheet time and cost. If both correction dates and timesheet dates are 

specified, the corrections reported will be for the timesheets filed within the 

specified timesheet dates. 

 

 If the resource plays more than one role in a project or an activity, the time 

reported from the timesheet will be equally distributed among all the roles 

and then costed with the respective role rate. 

 

Ad-Hoc Reports 

To access a set of pre-defined Ad-hoc Report templates, from the Top Navigation bar select Go To> 

Reports > Ad-hoc. 

You can also use the Left Navigation bar to select Reports > Ad-hoc Reports. 

In This Section 

Managing Ad-Hoc Reports ...................................................................................................................... 45 

List of Ad-Hoc Reports ........................................................................................................................... 46 

 
 

Managing Ad-Hoc Reports 

You can edit the parameters for these reports and save them for future use. You can edit the predefined 

templates by specify parameter values, selecting columns to be displayed and specifying the sort orders etc. 

You can view saved templates created by other users by changing the filter criteria. 
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Editing Templates 

To edit a template, click on the [Edit] link next to the template. Click on the tabs to modify the report and 

click on the Save As… button. 

General Tab 

Modify the name, and description. Select if you want the default output parameter to be HTML, PDF, XLS, 

or XML. Also select if you want to publish this report. 

Parameters Tab 

Select the parameters and their values. You can choose to edit the parameter at runtime. 

Column Selection Tab 

Select the columns you want to display. Click on the  and  buttons to select or omit columns from 

the report. You can also use the Move Up and Move Down buttons to change the order of the selected 

columns.  

Column Details Tab 

Select the column name and enter a description. 

Sorting Tab 

Select the sorting order for the columns. 

Run Test Report 

Select the output format (HTML, PDF, XLS, or XML) and enter values for any required parameters. Click 

on the Run Report button. 
 

Copying Templates 

To copy an existing template, click on the [Edit] link next to the template. Click on the tabs to modify the 

report and click the Save As… button. Enter a name and description for this report. Also, choose if you 

want publish this report. 
 

To set filters, click on the  More Filters… icon. Select the scope, and enter the filter criteria and click 

on the Apply button. Click the Reset button to reset the filters. To view the current filters click on the 

Show Current Filters link.  
 

To run an Ad-hoc report, do the following:  

1) Select a report and click on the [Run] link. 

2) From the Run Ad-hoc Report screen, select the output parameter and enter any mandatory 

parameters. 

3) Click the Run Report button. The screen refreshes to display the report. 
 

List of Ad-Hoc Reports 

The table below lists the pre-defined ad-hoc reports. 
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Report Name Description/Purpose 

Asset Listing Report Get all the asset related information for all resources. 

Charter Template A template for charter reports. 

Executive Notes Listing 

Template 

Lists all executive notes. 

Finance Validation Report 

Template 

Display finance validation data. 

Idea Template A template for idea reports. 

Issues Listing Report Lists issues in all projects. 

Metrics Listing Report Get all the metrics related information for all projects. 

Program Template A template for program reports. 

Project & Metrics Template This template combines project and metrics data. 

Project Listing Report Displays project details including a list of key team members. 

Project Template A template for project reports. 

Charter Team Member Listing 

Report 

Lists all charter team members. 

Resource Certification Listing 

Report 

Lists all certifications taken by resources. 

Resource Template A temple for resource reports. 

Role Based Permission List Lists all role based permissions. 

Team Member Listing Report Lists all team members. 

Title Based Permission List Display all title based permission mapping. 

 
 

User Defined Excel Reports 

User-Defined Excel Reports (also referred to as Composite reports) combines Microsoft Excel (as a tool 

for creating charts, pivot tables and tabular data in a highly customer-specific format) and EnterpriseTrack 

(as a single location repository for all users and a source of the latest real-time data from across your entire 

organization on your projects and related information such as status, charters and finances). As a result, 

your organization can enjoy the flexibility and control of your favorite desktop tool and the data reliability 

and productivity of a centralized on-demand source of project and portfolio information.  

For example, you can use User-Defined Excel reports if you need a Pivot Table report of Projects Finances 

by Organization and also display on the same page a chart of Project Finances by Time. Once you are setup 

with an Excel report template, you can then run the Pivot Table report as often as needed to access the 

updated report fed with the latest data from the system in an Excel output format.  



Dashboards and Reports User's Guide  

 

48 

 

You can create custom reports using one or more Ad-hoc templates as inputs and you can choose to 

output it as an XLS or as a zip file. One or more Ad-hoc report outputs can be inserted into separate sheets 

in Microsoft Excel. You can also view the history, email and share these reports.  

In This Section 

Creating User-Defined Reports ............................................................................................................ 48 

 
 

Creating User-Defined Reports 

To create User-Defined Reports, do the following:  

1) Navigate to Standard Reports by selecting Go To ® Reports ® Standard from the Top Navigation 

bar, or select Reports ® Standard from the Left Navigation bar. The Manage Reports screen is 

displayed. From the Tree pane, go to the My Report folder and select any reports sub-folder 

underneath. If you don’t have a sub-folder underneath the My Report folder, then you must create a 

sub-folder first. For example, you can create a sub-folder called <Excel-Based Report>. Highlight the 

Excel-Based Report, by selecting it.  

Note: You can specify any name for this sub-folder. Excel-Based Report is just an 

example. 

2) From the List pane, click on the Create User-Defined Report button. Click on the Selector 

button next to the icon and choose User-Defined Excel Report. 

3) From the General tab enter a name for the report. 

4) From the Data Source tab, you can add, or delete one or more Ad-hoc templates or you can select 

any of the available Standard Report templates. The Standard Reports that are displayed are the ones 

that have a tabular output. Most reports do, but those that have only a PDF output are not shown in the 

list of available reports.  

Notes: 

 You must choose a report that does not require any parameters at run-time. 

The report should produce an output without setting any parameters. 

 It is recommended that you make a copy of the Standard Report that you 

want to use as a data feed into your My Reports folder. This way you can set 

all necessary parameters that the Standard Report may need. If you are using 

Ad-hoc reports, you should similarly ensure that the reports do not require 

any input parameters 

5) Enter a name, select a source template, and enter an Order ID. You can click on the Add More link to 

add more source templates. This name will become the name of the tab in the output Excel report 

6) The Source is where you specify the Ad-hoc or Standard report templates that will be used as the data 

source to feed into your Report Template. You can have several sources of Ad-hoc or Standard 

reports. 

7) From the Output tab select the report format (XLS or ZIP). Select if you want to edit the parameters 

during runtime. 
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8) Click the  Run Report icon to run the report.  

9) You can open the report in Excel and add your own tabs. Your tabs can contain any Excel formulas, 

coloring, borders, text, charts, pivot tables and even Macros. These can refer to cells in the 

EnterpriseTrack data feed tabs.  

Note: You should not make any changes or edits to the tabs fed from 

EnterpriseTrack – these will be lost in a subsequent run of the report. You can 

however make any number of your own tabs. These tabs can have formulas that 

refer to the tabs of data fed by EnterpriseTrack. In this way you can create any 

arbitrary Excel output you wish. Note that when you refer to data ranges in the 

data tabs from EnterpriseTrack, you should know that there may be fewer or 

more rows in each run of the report depending on the underlying data set 

chosen. This can often be handled by just naming the column of data as the range 

in the Excel formula (e.g. A: A or C: C). 

10) From the Details tab, click on the General tab and upload the file you created in the previous step as 

the Report template. 

11) This template will then be populated at the next execution of the report, with the latest data. 

12) If you wish to change the template by modifying its appearance or any formulas, you can re-upload the 

modified template at any time. 

13) From the Output tab select the report format (XLS or ZIP). Select if you want to edit the parameters 

during runtime. 

14) Click the Save button, or click Cancel to discard your changes. 

15) From the List tab, select the report you created and click on the Schedule and Email tab.  

16) Select the run type (Manual or Scheduled). If you select Scheduled, then you can choose to send 

emails.  

17) From the History tab, you can view the history of this report. Click on the Edit icon to select how 

long you want to save the reports. 

18) The Sharing tab allows you to see if this report is shared with other team members. You can also edit 

this tab to allow others to view your report. 

19) From the List pane select the report you created and click on the  Run Report icon in the Action 

column to run the report.  

When the report is run, EnterpriseTrack will generate the report by populating the latest data into the 

tabs and retaining the formatting you set up. 

20) You can also set a bookmark for this Excel report – this way you can reduce the number of clicks 

required to run the report each time. 
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Where to Get Documentation 

For the most up-to-date versions of all manuals and technical documents related to installing, administering, 

and using EnterpriseTrack, go to: 

http://docs.oracle.com/cd/E50622_01/index.htm 

You can also access the versions of the product manuals and technical documents that were available at the 

time of the release from the Documentation Library, click index.htm in the Documentation folder of the 

physical media or download. 

Most documentation assumes a standard setup of the product, with full access rights to all features and 

functions. 

The following table describes the core documents available for EnterpriseTrack and lists the recommended 

readers by role. 

Title Description 

EnterpriseTrack User Help Describes how to work with EnterpriseTrack and provides 

information to assist users with using EnterpriseTrack features. 

All users should read this Help. 

EnterpriseTrack 

Administrator's Help 

Describes how to work with EnterpriseTrack Administrator's 

console to manage your deployment and change various aspects of 

the application. 

EnterpriseTrack administrator should read this Help. 

EnterpriseTrack User Guide Guides users on how to use the EnterpriseTrack application. 

All users should read this guide. 

EnterpriseTrack 

Administrator's Guide 

Provides detailed information on using the EnterpriseTrack 

Administrator's console. 

EnterpriseTrack administrator should read this guide. 

EnterpriseTrack Dashboard 

and Reports Guide 

Provides detailed instruction on using the EnterpriseTrack 

Dashboards and Reports modules to generate dashboards, 

standard reports, ad-hoc reports and user-defined reports. 

All users should read this guide. 

EnterpriseTrack Quick 

Reference Guide 

Provides a quick introduction to common EnterpriseTrack tasks. 

All users should read this guide. 
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Title Description 

EnterpriseTrack Installation 

Guide 

Provides information on how to install and configure 

EnterpriseTrack.  

EnterpriseTrack administrator, network administrator and 

database administrator should read this guide. 

EnterpriseTrack  MSP 

Integration Guide 

Provides an overview of MS Project integration for 

EnterpriseTrack. 

EnterpriseTrack users who will perform MS Project integration 

should read this guide. 

EnterpriseTrack API 

Integration Guide 

Provides information that allows customers to customize an 

existing third-party integration. 

Developers interested in customization and existing third-party 

providers that integrate with EnterpriseTrack should read this 

book. 

EnterpriseTrack Upgrade 

Guide 

Provides a sequence of procedures that must be completed to 

upgrade to a new version of EnterpriseTrack.  

EnterpriseTrack administrator and database administrator should 

read this guide. 

EnterpriseTrack Tested 

Configurations 

Lists the configurations that have been tested and verified to work 

with EnterpriseTrack.  

EnterpriseTrack administrator, network administrator, and 

database administrator should read this guide. 

EnterpriseTrack Cumulative 

Features Overview Tool 

Provides an overview of features and enhancements included in the 

Oracle EnterpriseTrack product. It is intended solely to help you 

assess the business benefits of upgrading. 

All users should read this guide. 

EnterpriseTrack Security 

Guide 

Provides guidelines on how to plan your security strategy for 

EnterpriseTrack. 

All users, EnterpriseTrack administrators, network administrators 

and database administrators should read this guide. 

Distributing Information to the Team 

You can copy the online documentation to a network drive for access by project participants. Each team 

member can then view or print those portions that specifically relate to his or her role in the organization. 

Throughout this documentation, the Security Guidance icon  helps you to quickly identify 

security-related content to consider during the installation and configuration process. 
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Where to Get Training 

To access comprehensive training for all Primavera products, go to: 

http://education.oracle.com 

Oracle Learning Library 

The Oracle Learning Library (OLL) provides online learning content covering Primavera products. Content 

includes videos, tutorials, articles, demos, step-by-step instructions to accomplish specific tasks, 

and  self-paced interactive learning modules. 

 

To access the learning library’s Primavera content, go to:  

http://www.oracle.com/goto/oll 
 

Where to Get Support 

Access to Oracle Support 

Oracle customers have access to electronic support through My Oracle Support. For information, visit 

http://www.oracle.com/us/support/contact-068555.html or visit 

http://www.oracle.com/us/corporate/accessibility/support/index.html if you are hearing impaired. 

Using Primavera's Support Resource Centers 

Primavera’s Support Resource Center provides links to important support and product 

information. Primavera's Product Information Centers (PICs) organize documents found on My Oracle 

Support (MOS), providing quick access to product and version specific information such as important 

knowledge documents, Release Value Propositions, and Oracle University training. PICs also offer 

documentation on Lifetime Management, from planning to installs, upgrades, and maintenance. 

Visit https://support.oracle.com/epmos/faces/DocumentDisplay?id=1486951.1 to access links to all of the 

current PICs. 

PICs also provide access to: 

 Communities are moderated by Oracle providing a place for collaboration among industry peers to 
share best practices.  

 News from our development and strategy groups. 

 Education contains a list of available Primavera product trainings through Oracle University. The 

Oracle Advisor Webcast program brings interactive expertise straight to the desktop using Oracle 

Web Conferencing technology. This capability brings you and Oracle experts together to access 

information about support services, products, technologies, best practices, and more.  

For more information about working with Support, visit 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=888813.2. 
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Oracle Instantis EnterpriseTrack Dashboards and Reports User's Guide 

Copyright © 2000, 2014, Oracle and/or its affiliates. All rights reserved. 

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks 

of their respective owners. 

This software and related documentation are provided under a license agreement containing restrictions 

on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in 

your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, 

license, transmit, distribute, exhibit, perform, publish or display any part, in any form, or by any means. 

Reverse engineering, disassembly, or decompilation of this software, unless required by law for 

interoperability, is prohibited. 

The information contained herein is subject to change without notice and is not warranted to be error-free. 

If you find any errors, please report them to us in writing. 

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it 

on behalf of the U.S. Government, the following notice is applicable:  

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, 

any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users 

are “commercial computer software" pursuant to the applicable Federal Acquisition Regulation and 

agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation 

of the programs, including any operating system, integrated software, any programs installed on the 

hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the 

programs. No other rights are granted to the U.S. Government. 

This software or hardware is developed for general use in a variety of information management 

applications. It is not developed or intended for use in any inherently dangerous applications, including 

applications that may create a risk of personal injury. If you use this software or hardware in dangerous 

applications, then you shall be responsible to take all appropriate failsafe, backup, redundancy, and other 

measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages 

caused by use of this software or hardware in dangerous applications. 

This software or hardware and documentation may provide access to or information on content, products 

and services from third-parties. Oracle Corporation and its affiliates are not responsible for and expressly 

disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle 

Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your 

access to or use of third-party content, products, or services. 
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